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Question Shuffling Allowed : Yes
  
Question Number : 1 Question Id : 2549896497 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following displays programs that are currently running in Windows 10 OS?
Options :
1.  Menu bar
2.  Task bar
3.  Title bar
4.  Status bar

  
Question Number : 1 Question Id : 2549896497 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सा �ो�ाम उन �ो�ामो ंको �दिश�त करता है जो वत�मान म� िवंडोज़ 10 ओएस म� चल रहे ह�?
Options :
1.  मेनू बार
2.  टा� बार
3.  टाइटल बार
4.  �ेटस बार

  
Question Number : 2 Question Id : 2549896883 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a unit of memory in the computers?
Options :
1.  Megabyte (MB)
2.  Gigabyte (GB)
3.  Nato byte (NB)
4.  Byte

  
Question Number : 2 Question Id : 2549896883 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन सी कं�ूटर म� �यु� मेमोरी की एक इकाई नही ंहै?
Options :
1.  मेगाबाइट (MB)

2.  गीगाबाइट (GB)

3.  नाटोबाइट (NB)

4.  बाइट
  
Question Number : 3 Question Id : 2549896885 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a type of RAM?
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Options :
1.  SRAM (Static RAM)
2.  Prime RAM
3.  DDR RAM (Double Data Rate RAM)
4.  SDRAM (Synchronous Dynamic RAM)

  
Question Number : 3 Question Id : 2549896885 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन सी एक �कार की RAM नही ंहै?
Options :
1.  SRAM (�ेिटक रैम)

2.  �ाइम RAM

3.  DDR RAM (डबल डेटा रेट रैम)

4.  SDRAM (िसं�ोनस डायनािमक रैम)
  
Question Number : 4 Question Id : 2549897535 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which keyboard shortcut is used to delete the text to the beginning of the word in an Open Office writer?
Options :
1.  Backspace
2.  Ctrl + Alt + Backspace
3.  Ctrl + Backspace
4.  Shift + Backspace

  
Question Number : 4 Question Id : 2549897535 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ओपन ऑिफस राइटर (OpenOffice writer) म�, िकसी श� की शु�आत से टे� को िडलीट करने के िलए िन� म� से िकस की-बोड� शॉट�कट का
उपयोग िकया जाता है?
Options :
1.  Backspace
2.  Ctrl + Alt + Backspace
3.  Ctrl + Backspace
4.  Shift + Backspace

  
Question Number : 5 Question Id : 2549897580 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______ is a volatile memory.
Options :
1.  RAM
2.  ROM
3.  EEPROM
4.  EPROM

  
Question Number : 5 Question Id : 2549897580 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन सी एक उदवायी मेमोरी है?
Options :
1.  RAM
2.  ROM
3.  EEPROM
4.  EPROM

  
Question Number : 6 Question Id : 2549898470 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following functions converts text to number in a locale independent manner in Microsoft Excel 2019?
Options :
1.  LOCLEVALUE function
2.  TEXTVALUE function
3.  NUMTEXTVALUE function
4.  NUMBERVALUE function

  
Question Number : 6 Question Id : 2549898470 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 म�, कौन सा फं�न िकसी �ानीय �तं� तरीके से टे� को अ�रो ंम� बदलता है?
Options :
1.  LOCLEVALUE फं�न
2.  TEXTVALUE फं�न
3.  NUMTEXTVALUE फं�न
4.  NUMBERVALUE फं�न

  
Question Number : 7 Question Id : 2549898812 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
An input device that allows a user to input data into a computer system by speaking to it is known as ______.
Options :
1.  Microphone
2.  Mouse
3.  Projector
4.  Scanner

  
Question Number : 7 Question Id : 2549898812 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन� म� से वह इनपुट िडवाइस कौन सी है िजसके �ारा बोलकर कं�ूटर िस�म म� डेटा इनपुट िकया जा सकता है?
Options :
1.  माइ�ोफोन
2.  माउस
3.  �ोजे�र
4.  �ैनर
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Question Number : 8 Question Id : 2549899353 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following devices is used for translating information from the computer into pictorial form on a paper?
Options :
1.  Light pen
2.  Keyboard
3.  Plotter
4.  Touch panel

  
Question Number : 8 Question Id : 2549899353 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िकसी इनफाम�शन को कं�ूटर से पेपर पर िच�ा�क �प म� प�रवित�त करने के िलए िन� म� से िकस िडवाइस का उपयोग िकया जाता है ?
Options :
1.  लाइट पेन
2.  कीबोड�
3.  �ॉटर
4.  टच पैनल

  
Question Number : 9 Question Id : 25498911744 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
CD is a(n) ______ type of data storage.
Options :
1.  optical
2.  electrical
3.  mechanical
4.  magnetic

  
Question Number : 9 Question Id : 25498911744 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
सीडी (CD), ___________ �कार का डेटा �ोरेज है।
Options :
1.  ऑि�कल
2.  इले���कल
3.  मैकेिनकल
4.  मै�ेिटक

  
Question Number : 10 Question Id : 25498922521 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The full form of ISP is ________.
Options :
1.  Intranet Service Provider
2.  Internet System Provider
3.  Internet Service Provider
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4.  Internet Service Plan
  
Question Number : 10 Question Id : 25498922521 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ISP का पूण��प �ा है?
Options :
1.  Intranet Service Provider (इंट� ानेट सिव�स �ोवाइडर)

2.  Internet System provider (इंटरनेट िस�म �ोवाइडर)

3.  Internet Service provider (इंटरनेट सिव�स �ोवाइडर)

4.  Internet Service Plan (इंटरनेट सिव�स �ान)
  
Question Number : 11 Question Id : 25498929851 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A barcode scanner eccentrically consists of three different parts, EXCLUDING:
Options :
1.  The illumination system
2.  The virtual locking system
3.  The sensor
4.  The decoder

  
Question Number : 11 Question Id : 25498929851 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक बारकोड �ैनर म� िवल�ण �प से तीन अलग-अलग भाग होते ह�, िसवाय:
Options :
1.  इलुिमनेशन िस�म
2.  वचु�अल लॉिकंग िस�म
3.  स�सर
4.  िडकोडर

  
Question Number : 12 Question Id : 25498930385 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In a Blue Ray Disc, Spacer-Layer thickness must be higher than ______ to avoid deterioration of the readout signal caused by the optical
crosstalk from adjacent layers.
Options :
1.  6 µm
2.  10 µm
3.  5 µm
4.  9 µm

  
Question Number : 12 Question Id : 25498930385 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
�ू रे िड� म�, आस� परतो ंसे ऑि�कल �ॉस टॉक के कारण रीडआउट िस�ल की िगरावट से बचने के िलए �ेसर-लेयर की मोटाई _______ से
अिधक होनी चािहए।
Options :
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1.  6 µm
2.  10 µm
3.  5 µm
4.  9 µm

  
Question Number : 13 Question Id : 25498930889 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
________ refers to the learning with the use of technology that enables people to learn anytime or anywhere.
Options :
1.  E-learning
2.  Email
3.  E-commerce
4.  E-banking

  
Question Number : 13 Question Id : 25498930889 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
________ �ौ�ोिगकी के उपयोग से सीखने को संदिभ�त करता है जो लोगो ंको कभी भी या कही ंभी सीखने म� स�म बनाता है।
Options :
1.  इ-लिन�ग (E-Learning)

2.  इ-मेल (E-Mail)

3.  इ-कॉमस�  (E-Commerce)

4.  इ-ब��िकंग (E-Banking)
  
Question Number : 14 Question Id : 25498930980 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following molecules are usually composed in thermotropic liquid crystals?
Options :
1.  Oval molecules
2.  Circular molecules
3.  Rod like molecules
4.  Water molecules

  
Question Number : 14 Question Id : 25498930980 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सा अणु आमतौर पर थम�ट� ोिपक तरल ि��ल म� बना होता है?
Options :
1.  अंडाकार अणु (Oval molecules)

2.  वृ�ाकार अणु (Circular molecules)

3.  छड़ के आकार के अणु (Rod like molecules)

4.  जल अणु (Water molecules)
  
Question Number : 15 Question Id : 25498931003 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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Which of the following is hexcode of command to 16 x 2 LCD instruction register to use '2 lines and 5 x 7 matrix'?
Options :
1.  0x38
2.  0x18
3.  0x14
4.  0x80

  
Question Number : 15 Question Id : 25498931003 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
'2 लाइन और 5 x 7 मैिट��' का उपयोग करने के िलए 16 x 2 एलसीडी अनुदेश रिज�र के कमांड का हे� कोड िन�िल�खत म� से कौन सा है?
Options :
1.  0x38
2.  0x18
3.  0x14
4.  0x80

  
Question Number : 16 Question Id : 2549898920 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following protocols working on the Transport layer provides a connectionless service between hosts?
Options :
1.  IP
2.  ARP
3.  TCP
4.  UDP

  
Question Number : 16 Question Id : 2549898920 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ट� ांसपोट� लेयर पर काय�रत वह कौन सा �ोटोकॉल है जो हो� के बीच एक कने�न रिहत सेवा �दान करता है?
Options :
1.  IP
2.  ARP
3.  TCP
4.  UDP

  
Question Number : 17 Question Id : 2549899514 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What will you do when print head CANNOT travel its full horizontal distance?
Options :
1.  Install correct drivers
2.  Open the cover and make sure there is nothing obstructing the movement of the print head
3.  install ink cartridge
4.  Clear the clogged ink cartridge  

  
Question Number : 17 Question Id : 2549899514 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
यिद ि�ंट हेड अपनी पूण� �ैितज दूरी तय नही ंकर पा रहा है, तो आप �ा कर� गे?
Options :
1.  सही ड� ाइवर �ािपत कर� .
2.  कवर खोल� और सुिनि�त कर�  िक ि�ंट हेड की गित म� कोई बाधा नही ंहै
3.  इंक कािट� �ज इन�ॉल कर�
4.  अव�� इंक कािट� �ज को साफ करना

  
Question Number : 18 Question Id : 2549899526 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
If you try to print a high-quality photo and use plain paper setting, then the printout is:
Options :
1.  smeared/messy
2.  normal
3.  colourful
4.  high quality

  
Question Number : 18 Question Id : 2549899526 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
यिद आप उ�-गुणव�ा वाली फ़ोटो ि�ंट करने का �यास करते ह� लेिकन आपने �ेन पेपर सेिटंग का उपयोग िकया है, तो �ा� ि�ंटआउट कैसा होगा?
Options :
1.  अ�� / मैला
2.  सामा�
3.  रंगीन
4.  उ� गुणव�ा वाला

  
Question Number : 19 Question Id : 25498910937 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following options of Windows 11 settings is used to connect a wireless printer?
Options :
1.  Bluetooth & devices 
2.  Network and internet
3.  Privacy & Security
4.  Personalization

  
Question Number : 19 Question Id : 25498910937 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
वायरलेस ि�ंटर को कने� करने के िलए िवंडोज 11 सेिटं� के िन�िल�खत म� से िकस िवक� का उपयोग िकया जाता है?
Options :
1.  �ूटूथ एंड िडवाइसेस
2.  नेटवक�  एंड इंटरनेट
3.  �ाइवेसी एंड िस�ो�रटी
4.  पेस�नालाइजेशन
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Question Number : 20 Question Id : 25498911140 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Saina has purchased an Apple phone. Which of the following operating systems is likely to be installed on her phone?
Options :
1.  Android
2.  Windows
3.  iOS
4.  Blackberry OS

  
Question Number : 20 Question Id : 25498911140 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
साइना ने एक ए�ल फोन खरीदा। उसके फ़ोन म� िन�िल�खत म� से कौन सा ऑपरेिटंग िस�म इं�ॉल होने की संभावना है?
Options :
1.  Android
2.  Windows
3.  iOS
4.  Blackberry OS

  
Question Number : 21 Question Id : 25498911278 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In Amplitude Modulation, generally, the modulation index is always ______ one.
Options :
1.  greater than or equal to
2.  greater than
3.  equal to
4.  less than

  
Question Number : 21 Question Id : 25498911278 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ए�लीटूड मॉडुलेशन म�, सामा� तौर पर मॉ�ूलेशन इंडे� हमेशा एक ______ होता है।
Options :
1.  से अिधक अथवा बराबर
2.  से अिधक
3.  के बराबर
4.  से कम

  
Question Number : 22 Question Id : 25498913858 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following property of DES makes cipher very strong?
Options :
1.  Avalanche effect, completeness
2.  Avalanche effect, incompleteness
3.  Newton effect, completeness
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4.  Newton effect, incompleteness
  
Question Number : 22 Question Id : 25498913858 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
DES का िन�िल�खत म� से कौन सा गुण िसफर को ब�त मजबूत बनाता है?
Options :
1.  अवालांचे �भाव, पूण�ता
2.  अवालांचे �भाव, अपूण�ता
3.  �ूटन �भाव, पूण�ता
4.  �ूटन �भाव, अपूण�ता

  
Question Number : 23 Question Id : 25498918552 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In which of the following OS intallation, the hard disk is formatted and completely erased?
Options :
1.  Clean Install
2.  In-Place Upgrade
3.  Repair Install
4.  Unrepair install

  
Question Number : 23 Question Id : 25498918552 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से िकस OS इं�ॉलेशन म�, हाड� िड� को फ़ॉम�ट िकया जाता है और पूरी तरह से िमटा िदया जाता है?
Options :
1.  �ीन इन�ॉल
2.  इन-�ेस अप�ेड
3.  �रपेयर इन�ॉल
4.  अन�रपेयर इन�ॉल

  
Question Number : 24 Question Id : 25498920750 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is a device that connects two or more packet-switched networks or subnetworks?
Options :
1.  Router
2.  Firewalls
3.  Switches
4.  Repeater

  
Question Number : 24 Question Id : 25498920750 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सा उपकरण है जो दो या दो से अिधक पैकेट-���ड नेटवक�  या सबनेटवक�  को जोड़ता है?
Options :
1.  राऊटर
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2.  फायरवॉल
3.  ��च
4.  �रपीटर

  
Question Number : 25 Question Id : 25498924309 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is an example of sequential file access method?
Options :
1.  accessing randomly relative to the current position of the file pointer
2.   using index to access the file directly. 
3.  accessing one record right after another record in an order
4.  reading and writing record rapidly in no particular order

  
Question Number : 25 Question Id : 25498924309 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन सा एक िस�� �िशयल फाइल ए�ेस �णाली का उदाहरण है?
Options :
1.  फ़ाइल सूचक की वत�मान ��ित के सापे� या���क �प से प�ँचना
2.  फ़ाइल तक सीधे प�ंचने के िलए इंडे� का उपयोग करना
3.  एक �म म� एक �रकॉड� के ठीक बाद दूसरे �रकॉड� तक प�ँचना
4.  पढ़ना और िलखना िबना िकसी िवशेष �म के तेजी से �रकॉड� होता है

  
Question Number : 26 Question Id : 25498924500 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ISO is a file format of ______.
Options :
1.  disk files
2.  disc image files
3.  video files
4.  audio files

  
Question Number : 26 Question Id : 25498924500 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ISO ____________ का फाइल फॉम�ट है।
Options :
1.  िड� फाइल
2.  िड� इमेज फाइल
3.  वीिडयो फाइल
4.  ऑिडयो फाइल

  
Question Number : 27 Question Id : 25498924604 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______ file has SWF file format.
Options :
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1.  Microsoft Encarta Document
2.  Adobe Flash Movie file
3.  Microsoft Office Document
4.  Image File

  
Question Number : 27 Question Id : 25498924604 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन� म� से िकस फाइल का फॉम�ट SWF होता है?
Options :
1.  माइ�ोसॉ� एनकाटा� डॉ�ूम�ट
2.  एडोब �लैश मूवी फाइल
3.  माइ�ोसॉ� ऑिफस डॉ�ूम�ट
4.  इमेज फाइल

  
Question Number : 28 Question Id : 25498925172 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The gzip method implements a public domain variation of:
Options :
1.  run length codes
2.  Huffman codes
3.  Lempel-Ziv algorithm
4.  dynamic Huffman codes

  
Question Number : 28 Question Id : 25498925172 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
gzip िविध म� िन� म� से कौन सी साव�जिनक डोमेन िविवधता लागू होती है?
Options :
1.  रन ल�थ कोड्स
2.  हफमैन कोड्स
3.  लेमपेल-िजव ए�ो�रदम
4.  डायनािमक हफमैन कोड्स

  
Question Number : 29 Question Id : 25498938508 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
_______ operating system runs on a set of computers that are interconnected by a network.
Options :
1.  Stand alone
2.  Distributed
3.  Off-line
4.  Batch processing

  
Question Number : 29 Question Id : 25498938508 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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_________ ऑपरेिटंग िस�म, कं�ूटर के उस सेट पर चलता है जो एक नेटवक�  �ारा आपस म� जुड़े �ए होते ह�।
Options :
1.  ��ड अलोन
2.  िड��� �ूटेड
3.  ऑफलाइन
4.  बैच �ोसेिसंग

  
Question Number : 30 Question Id : 25498940417 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In Microsoft Excel, a formula should always be preceded by a/an ______ sign.
Options :
1.  $
2.  =
3.  *
4.  #

  
Question Number : 30 Question Id : 25498940417 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel म�, िकसी फॉमू�ले के पहले हमेशा _________ िच� होना चािहए।
Options :
1.  $
2.  =
3.  *
4.  #

  
Question Number : 31 Question Id : 2549896764 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What is World Wide Web?
Options :
1.  It is a series of webpages that are typically accessed through a web browser and are hosted on a web server
2.  It refers to the Web browser in the user's machine or mobile device.
3.  A collection of websites or webpages stored in web servers and connected to local computers through the internet
4.  It is a software application used to retrieve data from webpages

  
Question Number : 31 Question Id : 2549896764 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
व�� वाइड वेब �ा है?
Options :
1.  यह वेबपेजो ंकी एक �ंृखला है जो आम तौर पर एक वेब �ाउज़र के मा�म से ए�ेस की जाती है और एक वेब सव�र पर हो� की जाती है
2.  यह उपयोगकता� की मशीन या मोबाइल िडवाइस म� वेब �ाउज़र को संदिभ�त करता है
3.  वेब सव�र म� सं�हीत और इंटरनेट के मा�म से �ानीय कं�ूटरो ंसे जुड़ी वेबसाइटो ंया वेबपेजो ंका एक सं�ह
4.  यह एक सॉ�वेयर ए��केशन है िजसका उपयोग वेबपेजो ंसे डेटा पुन�ा�� करने के िलए िकया जाता है
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Question Number : 32 Question Id : 2549899066 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______ transactions refer to situations where payment is done over the network and the amount gets transferred from one financial body
to another financial body without any involvement of a middleman.
Options :
1.  E-money
2.  E-bay
3.  E-biz
4.  E-plan

  
Question Number : 32 Question Id : 2549899066 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
_______ लेनदेन, उस ��ित को संदिभ�त करता है िजसम� भुगतान एक नेटवक�  पर िकया जाता है और रािश एक िव�ीय िनकाय से िकसी अ� िव�ीय
िनकाय पर िकसी म�� की भागीदारी के िबना ही �ानांत�रत हो जाती है।
Options :
1.  ई-मनी
2.  ई-बे
3.  ई-िबज़
4.  ई-�ान

  
Question Number : 33 Question Id : 2549899135 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The extensions .gov, .edu and .net are called:
Options :
1.  domain names
2.  mail to addresses
3.  email targets
4.  recipient's name

  
Question Number : 33 Question Id : 2549899135 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
.gov , .edu और .net ए�ट�सन �ा कहलाते ह�?
Options :
1.  डोमेन के नाम
2.  मेल के िलए एड� ेस
3.  ई-मेल टाग�ट्स
4.  �ा�कता�ओ ंके नाम

  
Question Number : 34 Question Id : 25498911068 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What do you understand by font family in Windows?
Options :
1.  It is a characteristic of a font and its style.
2.  It is a set of fonts that have a common design
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3.  It is defined in points which are often equal to pixels on computer display.
4.  It is sets of numbers, punctuation and letters.

  
Question Number : 34 Question Id : 25498911068 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िवंडोज़ म� फ़ॉ� प�रवार से आप �ा समझते ह�?
Options :
1.  यह िकसी फ़ॉ� और इसकी शैली की एक िवशेषता है
2.  यह फ़ॉ�्स का एक सेट है िजसम� एक सामा� िडज़ाइन होता है
3.  इसे उन िबंदुओ ंके �प म� प�रभािषत िकया जाता है जो अ�र कं�ूटर िड��े के िप�ल के बराबर होते ह�
4.  यह सं�ाओ,ं िवराम िच�ो,ं अ�रो ंका सेट है

  
Question Number : 35 Question Id : 25498911870 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a valid slide layout in MS-PowerPoint 2019?
Options :
1.  Title Slide
2.  Title and Content
3.  Section Header
4.  Paragraph Header

  
Question Number : 35 Question Id : 25498911870 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन MS-PowerPoint 2019 म� एक वैिलड �ाइड लेआउट नही ंहै?
Options :
1.  टाइटल �ाइड
2.  टाइटल एंड कंट�ट
3.  से�न हैडर
4.  पैरा�ाफ हैडर

  
Question Number : 36 Question Id : 25498911903 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
____________is the number system that we use on a daily basis based on the 10 digits. 
Options :
1.  binary
2.  decimal
3.  octal
4.  hexadecimal

  
Question Number : 36 Question Id : 25498911903 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
________ वह सं�ा �णाली है िजसका उपयोग हम 10 अंको ंके आधार पर दैिनक आधार पर करते ह�।
Options :
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1.  ि�धारी
2.  दशमलव
3.  अ�ाधारी
4.  षोडश आधारी

  
Question Number : 37 Question Id : 25498911947 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The binary equivalent of the decimal number '31' is ________.
Options :
1.  11111
2.  11011
3.  11110
4.  10111

  
Question Number : 37 Question Id : 25498911947 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दशमलव सं�ा '31' का बाइनरी समतु� �ा होगा?
Options :
1.  11111
2.  11011
3.  11110
4.  10111

  
Question Number : 38 Question Id : 25498924647 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which keyboard shortcut will you use to convert your text to BOLD in MS-Word 2019?
Options :
1.  ALT + B
2.  Ctrl + Shift + B
3.  Shift + F3
4.  Ctrl + B

  
Question Number : 38 Question Id : 25498924647 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 म� अपने टे� को BOLD म� बदलने के िलए आप िकस कीबोड� शॉट�कट का उपयोग कर� गे?
Options :
1.  ALT + B
2.  Ctrl + Shift + B
3.  Shift + F3
4.  Ctrl + B

  
Question Number : 39 Question Id : 25498924662 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The base of the Hexa Decimal  number system is ______.
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Options :
1.  16
2.  11
3.  12
4.  13

  
Question Number : 39 Question Id : 25498924662 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
 हे�ा दशमलव सं�ा प�ित की आधार सं�ा �ा है?
Options :
1.  16
2.  11
3.  12
4.  13

  
Question Number : 40 Question Id : 25498924671 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In the given number (8)10, 10 is the _______ of the number system.
Options :
1.  base
2.  power
3.  exponent
4.  cube

  
Question Number : 40 Question Id : 25498924671 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दी गई सं�ा (8)10 म�, 10 सं�ा �णाली का _______ है।
Options :
1.  Base (आधा�रक)

2.  Power (घातांकीय)

3.  Exponent (चर घातांकीय)

4.  Cube (घन)
  
Question Number : 41 Question Id : 25498925213 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following represents the binary number system?
Options :
1.  (11)10

2.  (11)2

3.  (11)8

4.  (11)16
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Question Number : 41 Question Id : 25498925213 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन सी सं�ा बाइनरी सं�ा �णाली से संबंिधत है?
Options :
1.  (11)10

2.  (11)2

3.  (11)8

4.  (11)16

  
Question Number : 42 Question Id : 25498925279 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
WAN stands for:
Options :
1.  Web Area Network
2.  World Area Network
3.  Wide Area Network
4.  Worst Area Network

  
Question Number : 42 Question Id : 25498925279 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
WAN का पूण��प �ा है?
Options :
1.  Web Area Network (वेब ए�रया नेटवक� )
2.  World Area Network (व�� ए�रया नेटवक� )
3.  Wide Area Network (वाइड ए�रया नेटवक� )
4.  Worst Area Network (व�� ए�रया नेटवक� )

  
Question Number : 43 Question Id : 25498938396 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The purpose of _______________ is to transform a URL into a normalized or canonical URL so it is possible to determine if two
syntactically different URLs are equivalent.
Options :
1.  URL normalization 
2.  URL support
3.  URL balancing
4.  URL modification

  
Question Number : 43 Question Id : 25498938396 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
_______________ का उ�े� एक यूआरएल को सामा�ीकृत या कैनोिनकल यूआरएल म� बदलना है तािक यह िनधा��रत करना संभव हो िक दो
वा�ा�क �प से िभ� यूआरएल समक� ह� या नही।ं
Options :
1.  URL सामा�ीकरण
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2.  URL समथ�न
3.  URL संतुलन
4.  URL संशोधन

  
Question Number : 44 Question Id : 25498941576 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The binary equivalent of the decimal number 3 is ______.
Options :
1.  101
2.  110
3.  111
4.  011

  
Question Number : 44 Question Id : 25498941576 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दशमलव सं�ा 3 का बाइनरी समतु� �ा होगा?
Options :
1.  101
2.  110
3.  111
4.  011

  
Question Number : 45 Question Id : 25498941580 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The octal equivalent of the binary number 1001 is _______.
Options :
1.  15
2.  11
3.  10
4.  8

  
Question Number : 45 Question Id : 25498941580 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
बाइनरी सं�ा 1001 का अ�ाधारी समतु� (octal equivalent) �ा होगा?
Options :
1.  15
2.  11
3.  10
4.  8

  
Question Number : 46 Question Id : 25498941594 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is the hardware in a computing device where the operating system, application programs and data in current use
are kept so they can be quickly reached by the device's processor?
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Options :
1.  RAM
2.  CD-ROM
3.  Flash Drive
4.  Hard Disk

  
Question Number : 46 Question Id : 25498941594 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सा एक कं�ूिटंग िडवाइस का हाड�वेयर है जहां ऑपरेिटंग िस�म, ए��केशन �ो�ाम और वत�मान उपयोग म� आने वाले डेटा
को रखा जाता है तािक उन तक िडवाइस के �ोसेसर �ारा ज�ी से प�ंचा जा सके?
Options :
1.  RAM
2.  CD-ROM

3.  �ैश ड� ाइव
4.  हाड� िड�

  
Question Number : 47 Question Id : 25498941600 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The decimal equivalent of the binary number '11011' is __________.
Options :
1.  23
2.  25
3.  27
4.  29

  
Question Number : 47 Question Id : 25498941600 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
बाइनरी सं�ा '11011' का दशमलव समतु� �ा होगा?
Options :
1.  23
2.  25
3.  27
4.  29

  
Question Number : 48 Question Id : 25498941619 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
________ is the shortcut key to apply a filter in MS-Excel 2019.
Options :
1.  Ctrl + Shift + L
2.  Ctrl + Shift + C
3.  Ctrl + Shift + K
4.  Ctrl + Shift + M

  
Question Number : 48 Question Id : 25498941619 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 म�, िफ़�र लगाने के िलए िकस की-बोड� शॉट�कट का उपयोग िकया जाता है।
Options :
1.  Ctrl + Shift + L
2.  Ctrl + Shift + C
3.  Ctrl + Shift + K
4.  Ctrl + Shift + M

  
Question Number : 49 Question Id : 25498941621 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In Microsoft Excel 2019, the Field List option should appear when you click anywhere in the _________ table.
Options :
1.  Data
2.  Reference
3.  Pivot
4.  Quick

  
Question Number : 49 Question Id : 25498941621 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 म�, जब आप _____ तािलका म� कही ंभी ��क करते ह� तो फ़ी� सूची िवक� िदखाई देना चािहए।
Options :
1.  डेटा
2.  रेफर�स
3.  िपवोट
4.  ि�क

  
Question Number : 50 Question Id : 25498941625 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is an example of email address?
Options :
1.  http://vianet.com/index.htm
2.  D:\ \Email\Standard
3.  joesmart@billme.com
4.  Chaminade.org/teachers/mail addresses

  
Question Number : 50 Question Id : 25498941625 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन ईमेल एड� ेस का उदाहरण है?
Options :
1.  http://vianet.com/index.htm
2.  D:\ \Email\Standard
3.  joesmart@billme.com
4.  Chaminade.org/teachers/mail addresses

  

7/15/24, 6:18 PM Online Question Paper PDF Preview



Question Number : 51 Question Id : 25498941641 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Identify the correct sequence of steps required to remove duplicate values in Microsoft Excel 2019.
Options :
1.  Go to the Data tab -> in data Tools group -> Click on Remove Duplicates
2.  Go to the Insert tab -> Click on Conditional Formatting -> Under Highlight Cells Rules click on Duplicate Values
3.  Go to the Design tab -> Click on Conditional Formatting -> Under Highlight Cells Rules click on Duplicate Values
4.  Go to the File tab -> Click on Conditional Formatting -> Under Highlight Cells Rules click on Duplicate Values

  
Question Number : 51 Question Id : 25498941641 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 म�, डु��केट मानो ंको हटाने के िलए आव�क चरणो ंके सही �म की पहचान कीिजए।
Options :
1.  डेटा टैब पर जाएं -> डेटा टू� �ुप म� -> �रमूव डु��केट्स पर ��क कर�
2.  इ�ट� टैब पर जाएं -> कंडीशनल फॉम��िटंग पर ��क कर�  -> हाइलाइट से� �� के अंतग�त डु��केट वै�ूज़ पर ��क कर�
3.  िडज़ाइन टैब पर जाएं -> कंडीशनल फॉम��िटंग पर ��क कर�  -> हाइलाइट से� �� के अंतग�त डु��केट वै�ूज़ पर ��क कर�
4.  फाइल टैब पर जाएं -> कंडीशनल फॉम��िटंग पर ��क कर�  -> हाइलाइट से� �� के अंतग�त डु��केट वै�ूज़ पर ��क कर�

  
Question Number : 52 Question Id : 25498941645 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In Microsoft Excel 2019, the pivot table error ‘field name is not valid’ usually appears because ________.
Options :
1.  one or more row heading cells in the source data are blank
2.  one or more of the column heading cells in the source data is blank

3.  one or more column cells in the source data are blank
4.  the worksheet with the pivot table is full

  
Question Number : 52 Question Id : 25498941645 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 म�, िपवोट टेबल एरर ‘field name is not valid’ सामा�तः  िकस कारण आती है?
Options :
1.  �ोत (Source) डेटा म� एक या अिधक पं��  (Row) शीष�क क�  (Heading Cell) �र� ह�।
2.  �ोत (Source) डेटा म� एक या अिधक �ंभ शीष�क क� (Column Heading Cell) �र� ह�।
3.  �ोत (Source) डेटा म� एक या अिधक �ंभ क� (Column Cell) �र� ह�।
4.  िपवट टेबल वाली वक� शीट भरी �ई है।
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Section Marks : 5
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897923
Question Shuffling Allowed : No
  
Question Id : 25498921283 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No Question Pattern Type : NonMatrix
Question Numbers : (53 to 57)
Read the given passage and answer the questions.

A young German workman came to Amsterdam. He went around the city and was deeply impressed by its beautiful buildings, ships and
busy people. He saw a large house more beautiful than any he had ever seen. For a long time he gazed at it in astonishment, its six
chimneys and its tall windows looked awesome. Finally, he asked a passer-by, “Could you please tell me the name of the gentleman who
owns this beautiful house?” But the man, who had more important matters to attend to, and who did not understand German, replied
‘Kannitverstan’ and went away. (This is a Dutch word which means “I cannot understand you.”) ``He must have been an awfully rich
man, this Mr. Kannitverstan,” our hero thought.

Walking through the streets of the town he came to the harbor. There were many ships there. His attention was caught by a large ship
which was being unloaded. Barrels full of sugar, coffee, rice and pepper were being rolled out. When he had watched for a long time, he
asked a man for the name of the man for whom the ship had brought all these goods. “Kannitverstan” was the reply. At this he thought,
“Aha, so that's how he can afford such a wonderful and amazing house.”

So he went away sorrowfully thinking how poor a man he was among so many rich people in this world. Just then, he turned a corner and
saw a long funeral procession. Four horses were pulling a black coffin box. A large number of people followed silently. Our hero stood
there in respect with his hat in his hands until they had all passed by. Then, he went up to the last man in the procession and said, “That
must have been a good friend of yours,” he said, “Who was he?” “Kannitverstan!?” came the reply.

He felt sad and relieved at once. “Poor Kannitverstan,” he exclaimed to himself, “What do you get from all your wealth now? I will get
the same from my poverty: a shroud and a sheet!” With these thoughts in mind, he accompanied the procession to the grave. He saw the
supposed Mr. Kannitverstan being lowered to his final resting place.
Sub questions
 
Question Number : 53 Question Id : 25498921284 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Who was Kannitverstan?
Options :
1.  A rich merchant
2.  A Dutchman
3.  The man who died
4.  Nobody
 
Question Number : 54 Question Id : 25498921285 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Whom does the term ‘our hero’ used in the passage refer to?
Options :
1.  Kannitverstan
2.  The passer-by
3.  The German traveler
4.  The man who died
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Question Number : 55 Question Id : 25498921286 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
When the traveler understood that the goods from the ship belonged to Kannitverstan, he was:
Options :
1.  sad at his own poverty
2.  amazed at the goods
3.  astonished to see the ship
4.  happy with the man’s riches
 
Question Number : 56 Question Id : 25498921287 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
When he discovered that Kannitverstan had died, the man was sad because:
Options :
1.  a very rich man had died
2.  a large crowd walked silently
3.  his wealth was of no use to him now
4.  his body was in a black coffin box
 
Question Number : 57 Question Id : 25498921288 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following options does NOT complete the given statement correctly?

After seeing the coffin, the traveler felt relieved because he understood that:
Options :
1.  there is no use of wealth after death
2.  in death a poor man also gets only a sheet
3.  death does not distinguish between the rich and the poor
4.  only the rich go to heaven

  
Question Id : 25498921283 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No Question Pattern Type : NonMatrix
Question Numbers : (53 to 57)
िदए गए ग�ांश को पढ़�  और उसके आधार पर ��ो ंके उ�र द�।

एक युवा जम�न कारीगर ए��ड�म आया। वह पूरे शहर म� घूमा और यहां की खूबसूरत इमारतो,ं जहाजो ंऔर �� लोगो ंसे काफी �भािवत �आ। उसने
एक बड़े से संुदर घर को देखा, इतना संुदर घर उसने पहले कभी नही ंदेखा था। वह उसे बड़ी देर तक एकटक देखता रहा। इसकी छः  िचमिनयां और
लंबी-लंबी �खड़िकयां शानदार लग रही थी।ं अंत म� उसने वहां से गुजर रहे एक ��� से पूछा, "�ा आप मुझे इस खूबसूरत घर के मािलक का नाम
बता सकते ह�?" लेिकन वह आदमी िकसी और काम की वजह से ज�बाज़ी म� था और उसे जम�न भी ठीक से समझ म� नही ंआती थी, "कि�टवे��न"
बोलकर आगे बढ़ गया। (यह एक डच श� है िजसका अथ� है "आपकी बात मुझे समझ नही ंआई।") हमारे नायक ने सोचा, "�ी कि�टवे��न अव� ही
ब�त अमीर ��� होगें।”

शहर की सड़को ंपर घूमते �ए वह बंदरगाह तक प�ंच गया। वहां कई जहाज थे। उनका �ान एक बड़े जहाज पर की ओर गया िजसपर से सामान
उतारा जा रहा था। चीनी, कॉफी, चावल और काली िमच� से भरे बैरल उसम� से िनकाले जा रहे थे। वह यह ब�त देर तक सबकुछ देखता रहा िफर उसने
वहां पर एक ��� से पूछा िक जहाज से लाया जा रहा यह सब सामान िकसका है? जवाब िफर से "कि�टवे��न" था। अब उसे समझ आया िक
"कि�टवे��न इतने संुदर घर का मािलक कैसे बना।"

इसिलए वह यह सोचकर दुखी होकर चला गया िक इस दुिनया म� इतने सारे अमीर लोगो ंके बीच वह िकतना गरीब आदमी था। तभी, वह एक कोने म�
मुड़ा और एक लंबी शवया�ा देखी। चार घोड़े एक काले ताबूत को खीचं रहे थे। बड़ी सं�ा म� लोग चुपचाप उसके पीछे-पीछे जा रहे थे। हमारा नायक
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उसके स�ान म� तब तक अपने हाथो ंम� अपनी टोपी लेकर शांत खड़ा रहा जबतक सभी लोग वहां से िनकल नही ंगए। िफर, वह जुलूस म� आ�खरी
आदमी के पास गया और बोला, "वह तु�ारा कोई अ�ा दो� रहा होगा," उसने कहा, "वह कौन था?" "कि�टवे��न!?" जवाब आया।

उसे राहत िमि�त दुः ख �आ। "बेचारा कि�टवे��न," उसने खुद से कहा, "अब तु�� अपनी सारी दौलत से �ा िमलेगा? मुझे अपनी गरीबी से भी वही
िमलेगा: एक कफ़न और एक चादर!" इन िवचारो ंको मन म� लेकर वह जुलूस के साथ क� तक गया। उ�ों�ने किथत िम�र कि�टवे��न को उनके
अंितम िव�ाम �ल पर ले जाते �ए देखा।
Sub questions
 
Question Number : 53 Question Id : 25498921284 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
कि�टवे��न कौन था?
Options :
1.  एक धनी �ापारी
2.  एक डचमैन
3.  ��� जो मर गया था
4.  कोई भी नही ं
 
Question Number : 54 Question Id : 25498921285 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ग�ांश म�, "हमारा नायक" श� िन� म� से िकसके िलए �यु� �आ है?
Options :
1.  के�ीवे��न के िलए
2.  राहगीर के िलए
3.  जम�न या�ी के िलए
4.  मृत ��� के िलए
 
Question Number : 55 Question Id : 25498921286 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जब या�ी को पता चला िक जहाज से उतारा जा रहा सामान कि�टवे��न का है, तो वह ____________ |
Options :
1.  अपनी गरीबी पर उदास �आ
2.  सामान देखकर आ�य�चिकत �आ
3.  जहाज को देखने से आ�य�चिकत �आ
4.  आदमी के धन से खुश �आ
 
Question Number : 56 Question Id : 25498921287 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जब उसे पता चला िक मृत ��� कि�टवे��न है, तो वह दुखी �ो ं�आ?
Options :
1.  इसिलए िक एक अमीर ��� की मृ�ु हो गई है
2.  इसिलए िक ब�त सी भीड़ मृत ��� के पीछे पीछे जा रही है
3.  इसिलए िक उसका धन अब उसके कभी काम नही ंआएगा
4.  इसिलए �ों�िक उसका मृत शरीर एक काले ताबूत म� था
 
Question Number : 57 Question Id : 25498921288 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन सा िवक� नीचे िदए गए कथन को सही ढंग से पूण� नही ंकरेगा?
ताबूत देखने के बाद या�ी को राहत महसूस �ई �ों�िक;
Options :
1.  मृ�ु के बाद धन का कोई उपयोग नही ंहै
2.  मृ�ु के बाद एक गरीब आदमी को भी केवल एक चादर ही िमलती है
3.  मृ�ु अमीरो ंऔर गरीबो ंके बीच अंतर नही ंकरती है
4.  केवल अमीर ही �ग� म� जाते ह�

  
  

QUANTITATIVE APTITUDE
Section Id : 2549897883
Section Number : 3
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897924
Question Shuffling Allowed : Yes
  
Question Number : 58 Question Id : 25498928864 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Find the sum of first 15 terms of the Arithmetic series 3, 7, 11, 15, …….
Options :
1.  412
2.  440
3.  465
4.  488

  
Question Number : 58 Question Id : 25498928864 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
अंकगिणत �ंृखला 3, 7, 11, 15, …… के पहले 15 पदो ंका योग �ात कीिजए।
Options :
1.  412
2.  440
3.  465
4.  488

  
Question Number : 59 Question Id : 25498928919 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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Options :
1.  840
2.  910
3.  1320
4.  1120

  
Question Number : 59 Question Id : 25498928919 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 60 Question Id : 25498928935 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What should come in place of the question mark (?) in the following?

? % of 800 = 293 - 22% of 750
Options :
1.  14
2.  18
3.  12
4.  16

  
Question Number : 60 Question Id : 25498928935 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� �� िच� (?) के �ान पर �ा आना चािहए?

800 का  ?% = 293 - 750 का 22%
Options :
1.  14
2.  18
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3.  12
4.  16

  
Question Number : 61 Question Id : 25498929112 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Aman is a cricketer and his average score in ten matches is 40. If his average score in the first five matches is 45, then what is his average
score in the last five matches?
Options :
1.  38
2.  37
3.  36
4.  35

  
Question Number : 61 Question Id : 25498929112 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
अमन एक ि�केटर है और दस मैचो ंम� उसका औसत �ोर 40 है। यिद पहले पांच मैचो ंम� उसका औसत �ोर 45 है, तो अंितम पांच मैचो ंम� उसका
औसत �ोर �ा है?
Options :
1.  38
2.  37
3.  36
4.  35

  
Question Number : 62 Question Id : 25498929428 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
If Sn is the sum of the first n terms of an arithmetic progression and S9 = 72, then the sum of its 2nd, 4th and 9th terms is:
Options :
1.  20
2.  24
3.  30
4.  36

  
Question Number : 62 Question Id : 25498929428 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  
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4.  

  
Question Number : 63 Question Id : 25498929446 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The entry fee to an exhibition was reduced by 25%, which increased the sale by 20%. The percentage increase in the number of visitors
was :
Options :
1.  40%
2.  55%
3.  60%
4.  80%

  
Question Number : 63 Question Id : 25498929446 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक �दश�नी म� �वेश शु� 25% कम कर िदया गया, िजससे िब�ी 20% बढ़ गई। आगंतुको ं(Visitors) की सं�ा म� िकतने �ितशत की वृ�� �ई?
Options :
1.  40%
2.  55%
3.  60%
4.  80%

  
  

GENERAL MENTAL ABILITY AND REASONING
Section Id : 2549897884
Section Number : 4
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897925
Question Shuffling Allowed : Yes
  
Question Number : 64 Question Id : 25498910064 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following words will come second if all of them are arranged alphabetically as in a dictionary?
Options :
1.  Tennis
2.  Tendon
3.  Tender
4.  Tempest
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Question Number : 64 Question Id : 25498910064 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िवक�ो ंम� िदए गए श�ो ंको यिद अं�ेजी श�कोश के अनुसार वणा�नु�म म� �व��त िकया जाए, तो िन� म� से कौन सा श� दूसरे �ान पर
आएगा?
Options :
1.  Tennis
2.  Tendon
3.  Tender
4.  Tempest

  
Question Number : 65 Question Id : 25498910152 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the option that is related to the third word in the same way as the second word is related to the first word.

Entrepreneur : Profit :: Scholar : ?
Options :
1.  Income
2.  Knowledge
3.  Service
4.  Business

  
Question Number : 65 Question Id : 25498910152 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
उस िवक� का चयन कर�  जो तीसरे श� से उसी �कार संबंिधत है जैसे दूसरा श� पहले श� से संबंिधत है।

उ�मी : लाभ :: िव�ान : ?
Options :
1.  आय
2.  �ान
3.  सेवा
4.  �ापार

  
Question Number : 66 Question Id : 25498919025 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the word from the options that is similar to the given set of words in a certain way.

Dozen, Score, Decade
Options :
1.  Century
2.  Number
3.  Measurement
4.  Counting

  
Question Number : 66 Question Id : 25498919025 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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िवक�ो ंम� से उस श� का चयन कर�  जो एक िनि�त तरीके से िदए गए श�ो ंके समूह के समान है।

दज�न, �ोर, दशक
Options :
1.  शता�ी
2.  सं�ा
3.  माप
4.  िगनती

  
Question Number : 67 Question Id : 25498919616 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the most appropriate description about the given set of words.

Kanha : Periyar : Dachigam
Options :
1.  These are famous lagoons.
2.  These are hill stations.
3.  These are animal sanctuaries.
4.  These are mountain peaks.

  
Question Number : 67 Question Id : 25498919616 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िदए गए श�ो ंके समूह के बारे म� सबसे उपयु� िववरण का चयन कर�।

का�ा: पे�रयार: दाचीगाम
Options :
1.  ये सभी �िस� झील� ह�।
2.  ये सभी पहाड़ी �ल ह�।
3.  ये सभी व�जीव अ�ार� ह�
4.  ये सभी पव�त चोिटयां ह�।

  
Question Number : 68 Question Id : 25498939756 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
'THEREFORE' is related to 'TEEOERFRH' in the same way as 'HELICOPTER' is related to '___________'.
Options :
1.  HELICORETP
2.  HLCPERTOIE
3.  RETPOCILEH
4.  RETPOCILHE

  
Question Number : 68 Question Id : 25498939756 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
THEREFORE, TEEOERFRH से उसी �कार से संबंिधत है, िजस �कार HELICOPTER, ________________से संबंिधत है।
Options :
1.  HELICORETP
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2.  HLCPERTOIE
3.  RETPOCILEH
4.  RETPOCILHE

  
Question Number : 69 Question Id : 25498940047 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the word-pair in which the two words share a different relationship from that shared by the two words in the rest of the word-pairs.
Options :
1.  Avesta : Parsi
2.  Torah : Jew
3.  Tripitaka : Buddhist
4.  Temple : Hindu

  
Question Number : 69 Question Id : 25498940047 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
उस श�-यु� का चयन कर�  िजसम� दो श� शेष श�-जोिड़यो ंम� दो श�ो ं�ारा साझा िकए गए संबंध से िभ� संबंध साझा करते ह�।
Options :
1.  अवे�ा : पारसी
2.  तोराह : य�दी
3.  ि�िपटक : बौ�धम�
4.  मंिदर : िहंदू

  
  

GENERAL AWARENESS
Section Id : 2549897885
Section Number : 5
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897926
Question Shuffling Allowed : Yes
  
Question Number : 70 Question Id : 2549895329 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Kudremukh hills, known for iron ore deposits, is situated in:
Options :
1.  Chikmagalur
2.  Mangalore
3.  Satara
4.  Belgaum
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Question Number : 70 Question Id : 2549895329 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
लौह अय� भंडार के िलए �िस� कु�ेमुख पहािड़यां कहाँ पर ��त है?
Options :
1.  िचकमंगलूर
2.  मंगलौर
3.  सातारा
4.  बेलगाम

  
Question Number : 71 Question Id : 2549899665 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Gold mines in India are located mainly at:
Options :
1.  Kolar
2.  Raniganj
3.  Jadugoda
4.  Veeranam

  
Question Number : 71 Question Id : 2549899665 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
भारत म� सोने की खान, मु�तः  ______ म� ��त ह�।
Options :
1.  कोलार
2.  रानीगंज
3.  जादुगोडा
4.  वीरानम

  
Question Number : 72 Question Id : 25498912801 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Who amongst the following is the highest wicket taker in the history of cricket as of October 2021? (Both ODI and Test Cricket)
Options :
1.  Wasim Akram
2.  Anil Kumble
3.  Stephen Fleming
4.  Muttiah Muralitharan

  
Question Number : 72 Question Id : 25498912801 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
अ�ूबर 2021 तक ि�केट के इितहास म� िन�िल�खत म� से कौन सबसे अिधक िवकेट लेने वाला ग�दबाज है? (वनडे और टे� ि�केट दोनो)ं
Options :
1.  वसीम अकरम
2.  अिनल कंुबले
3.  �ीफन �ेिमंग
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4.  मुथैया मुरलीधरन
  
Question Number : 73 Question Id : 25498922846 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following has the scientific name Pheretima posthuma?
Options :
1.  Leech
2.  Nereis
3.  Earthworm
4.  Tapeworm

  
Question Number : 73 Question Id : 25498922846 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
फेरेिटमा पो��मा (Pheretima posthuma), िन�िल�खत म� से िकस िवक� का वै�ािनक नाम है?
Options :
1.  लीच
2.  ने�रस
3.  क� चुआ
4.  फीता कृिम

  
Question Number : 74 Question Id : 25498933645 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which amendment of the Constitution of India provides constitutional status to the Panchayati Raj institution?
Options :
1.  71st Amendment

2.  73rd Amendment

3.  77th Amendment

4.  79th Amendment
  
Question Number : 74 Question Id : 25498933645 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
भारत के संिवधान का कौन सा संशोधन पंचायती राज सं�ा को संवैधािनक दजा� �दान करता है?
Options :
1.  71 वां संशोधन
2.  73 वां संशोधन
3.  77 वां संशोधन
4.  79 वां संशोधन

  
Question Number : 75 Question Id : 25498935418 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The excess of price that a person is to pay rather than forego the consumption of a commodity is called ______________.
Options :
1.  price
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2.  profit
3.  producer’s surplus
4.  consumer’s surplus

  
Question Number : 75 Question Id : 25498935418 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िकसी व�ु की खपत �ागने के बजाय ��� �ारा भुगतान की जाने वाली अित�र� कीमत िन�िल�खत म� से �ा कहलाती है?
Options :
1.  कीमत
2.  लाभ
3.  उ�ादक अिधशेष
4.  उपभो�ा अिधशेष

  
  

English Mock
Group Number : 2
Group Id : 2549894964
Group Maximum Duration : 5
Group Minimum Duration : 5
Show Attended Group? : No
Edit Attended Group? : No
Break time : 1
Mandatory Break time : Yes
Group Marks : 0
  
  

English Mock
Section Id : 2549897886
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897927
Question Shuffling Allowed : No
Is Section Default? : Yes
  
Question Number : 76 Question Id : 25498941117 Question Type : TYPING TEST Display Question Number : Yes Calculator :
None
Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork,
socializing, decision making, independent and responsible living and more. It aids the overall development of a child and children
have fun during this process as they get to explore new arenas.
Restricted/ Unrestricted : Unrestricted
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Paragraph Display : Yes
Keyboard Layout : Inscript
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes
  
  

English Actual
Group Number : 3
Group Id : 2549894965
Group Maximum Duration : 15
Group Minimum Duration : 15
Show Attended Group? : No
Edit Attended Group? : No
Break time : 3
Mandatory Break time : Yes
Group Marks : 0
  
  

English Typing Test
Section Id : 2549897887
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897928
Question Shuffling Allowed : No
Is Section Default? : Yes
  
Question Number : 77 Question Id : 25498941466 Question Type : TYPING TEST Display Question Number : Yes Calculator :
None
There is a consensus of expert opinion that cricket may have been invented during Saxon or Norman times by children living in
the Weald. It is an area of dense woodlands and clearings in south England. The first reference to cricket being played as an adult
sport was in early sixteenth century. In the same year a dictionary defined cricket as a game. There is also the thought that
cricket may have derived from bowls. It was an intervention of a batsman trying to stop the ball from reaching its target by
hitting it away. Village cricket had developed by the middle of the seventeenth century. The first English county teams were
formed in the second half of the same century. The local experts from village cricket were employed as the earliest professionals.
The first known game in which the teams use county names was played in the first decade of the seventeenth century. In the first
half of the eighteenth century cricket established itself as a leading sport in London and its nearby counties. Its spread was
limited by the constraints of travel. Still it was slowly gaining popularity in all the other parts of England. The first laws of
cricket were written in the middle of the seventeenth century. In the last quarter of seventeenth century these laws were
amended. The two prime changes being the addition of the third stump and defining the maximum bat width. The codes were
drawn up by the Star and Garter Club. The members of this club ultimately founded the famous Marylebone Cricket Club.
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Marylebone Cricket Club immediately became the custodian of the laws and has made revisions ever since then to the current
day. Cricket was introduced to North America via the English colonies as early as the seventeenth century. In the eighteenth
century it arrived in other parts of the globe. It was introduced to the West Indies by colonists and to India by British East India
Company mariners. It arrived in Australia almost as soon as colonisation began and the sport reached New Zealand and South
Africa in the early years of the nineteenth century. The development of the railway network also helped the spread of cricket as
teams from a long distance apart could play one other without a time consuming journey. Now even the spectators could travel
longer distances to matches. This resulted in increasing the size of crowds. The overarm bowling was leaglised in the seventh
decade of eighteenth century. It also marked a notable first with the publication of the first Wisden Almanack. This continues to
this day. In the same year Grace began his long and influential career. He contributed greatly in increasing the popularity of the
cricket. The first every international cricket game was played between the United State and Canada. This game was played in the
middle of the eighteenth century. Six year after the first English team toured Australia a team of Australian aborigines toured
England. The first test matched were played at the start of the last quarter of the nineteenth century. The following year
Australians toured England for the first time and the success of this tour ensured a popular demand for similar ventures in
future. The Australian victory in a tense finish gave rise to The Ashes series.
Restricted/ Unrestricted : Unrestricted
Paragraph Display : Yes
Keyboard Layout : Inscript
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes
  
  

Hindi Mock
Group Number : 4
Group Id : 2549894966
Group Maximum Duration : 10
Group Minimum Duration : 10
Show Attended Group? : No
Edit Attended Group? : No
Break time : 5
Mandatory Break time : Yes
Group Marks : 0
  
  

Hindi Mock
Section Id : 2549897888
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897929
Question Shuffling Allowed : No
Is Section Default? : Yes
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Question Number : 78 Question Id : 25498944390 Question Type : TYPING TEST Display Question Number : Yes Calculator :
None
एक बार की बात है, अकबर और बीरबल िशकार पर जा रहे थे। अभी कुछ समय की उ�� एक िहरण िदखा। ज�बाजी म� तीर िनकालते �ए
अकबर अपने हाथ पर घाव लगा बैठा। अब हालात कुछ ऐसे थे की अकबर ब�त दद� म� था और गु�े म� भी।
Restricted/ Unrestricted : Unrestricted
Paragraph Display : Yes
Keyboard Layout : Remington
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes
  
  

Hindi Actual
Group Number : 5
Group Id : 2549894967
Group Maximum Duration : 15
Group Minimum Duration : 15
Show Attended Group? : No
Edit Attended Group? : No
Break time : 0
Group Marks : 0
  
  

Hindi Typing Test
Section Id : 2549897889
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897930
Question Shuffling Allowed : No
Is Section Default? : Yes
  
Question Number : 79 Question Id : 25498945133 Question Type : TYPING TEST Display Question Number : Yes Calculator :
None
सपने हमारे आनेवाले कल को सही आकार देने म� एक ज�री भूिमका िनभाते ह�। यह सच ही कहा गया है िक यिद आप कुछ सोच सकते ह� तो
आप उसे हािसल भी कर सकते ह�। इसिलए यिद आपके पास सपना है तो इसे अपनी मंिजल के �प म� कायम कर�  और इसे हािसल करने के
िलए कडी मेहनत कर�। हालांिक यह कहना ब�त आसान है बजाए करने के लेिकन अगर आप सच म� इसे हािसल करने के िलए कडी मेहनत
करते ह� तो आप इसे ज�र हािसल करने म� स�म होगें। िजंदगी म� आपका एक बडा सपना हो सकता है लेिकन इसे हािसल करने के िलए
आपको छोटे और बडे दोनो ंही इरादे रखने होगें। हमेशा एक समय म� एक कदम उठाना ही आपकी मदद कर सकता है। उदाहरण के िलए
मेरा सपना फैशन िडजाइनर बनना है और म� जानता �ं िक यह तभी संभव होगा यिद म� िकसी नामी पीठ से फैशन िडजाइिनंग म� कोस� पूरा
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क�ं। हालांिक फैशन की दुिनया के बारे म� जानने के िलए फैशन मैगजीन देखने से मुझे कोई नही ंरोक सकता। ऐसे छोटे कदम उठाने से म�
अपने सपनो ंको पा सकता �ं। हालांिक मेरी अंितम मंिजल एक फैशन िडजाइनर बनना है। म�ने आने वाले महीनो ंऔर वष� के िलए कई छोटी
चीजे िनधा��रत की ह� तािक ये मुझे अपनी अंितम मंिजल तक ले जा सक� । सपनो ंको हािसल करने म� �मुख बाधाओ ंम� एक �ेरणा की कमी है।
ब�त से लोग अपने सपनो ंको पूरा करना छोड देते ह� वे बीच म� थक जाते ह�। सपने पूरे करने के िलए �े�रत रहना ज�री है और जब आप
अपना सपना पूरा कर ल� तब ही �क� । यिद कभी आप अपने आप को िनराश और थका �आ मानते ह� तो यह अपनी अंितम मंिजल को याद
करने का समय है और असली आनंद तथा गौरव का अनुभव आपको तब होगा जब आप इसे हािसल कर� गे। आप एक चीज को भी हािसल
करने के िलए इनाम रख�। खुद को एक पोशाक खरीदने या अपने पसंदीदा कैफे पर जाकर या िम�ो ंके साथ बाहर जाने जैसा कुछ भी हो
सकता है। अपनी मंिजल को हािसल करने के िलए �े�रत रहने का यह एक सही तरीका है। ब�त अिधक काम और िकसी �कार का खेल ना
खेलना आपके िनमा�ण को कमजोर कर सकता है। इस �कार यह एक बेहतर िवचार है िक आप अपने काम से कुछ समय िनकाले और ऐसा
काम करे िजसे करने म� आपको आनंद आता है। आदश� �प से आप अपने पसंदीदा खेल म� शािमल होने के िलए हर िदन अपने काय��म से
आधा घंटा िनकाल ले। उन लोगो ंके साथ रह� जो आपके सपनो ंम� यकीन रखते ह� और आपको �े�रत रहने के िलए कडी मेहनत करने के िलए
जोश भरते ह�। यह �े�रत रहने के िलए एक बिढया तरीका है। िनराश होने और अपने सपनो ंको छोडने के बजाए जब आप गलती करते ह�
और किठन समय का सामना करते ह� तो आपको अपनी गलितयो ंसे सीखने और खुद को मजबूत करने की कोिशश करनी चािहए। जैसे
आप अपने सपने और मंिजल को िनधा��रत करते ह� तो उसके िलए एक योजना बनाना ज�री है जो आपको सही िदशा म� जाने के िलए
सहायता करे। योजना तैयार करना और संगिठत रहकर अपने सपने को हािसल करना �ारंिभक कदम ह�। बडे सपने दे�खए और हर बाधा
को दूर करने के िलए कडी मेहनत क�रए।
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